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Chapter 1: Introduction
Welcome to xMatters for HP Service Manager Change Management. This document describes how to install and
configure the xMatters for HP Service Manager Change Management software integration. The intended audience for
this document is experienced consultants, system administrators and other technical readers.

1.1 Summary
xMatters is an interactive alerting application, designed to capture and enrich important events, to route those events
to the right person on any communication device, and to give that person the ability to solve, escalate, or enlist
others to resolve the events remotely.

xMatters allows you to take critical business information and contact the right people via voice phone, SMS, two-
way pagers, instant message, and email.

Through integration modules, xMatters can become the voice and interface of an automation engine or intelligent
application (the Management System, such as HP Service Manager Change Management). When HP Service
Manager detects something that requires attention, xMatters places phone calls, sends pages, messages, or emails to
the appropriate personnel, vendors or customers.

xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or
resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with HP
Service Manager Change Management. Responses are executed immediately on HP Service Manager, enabling
remote resolution of the event.

This integration supports change request notifications (from HP Service Manager to xMatters). It also supports
inbound actions (from xMatters to HP Service Manager).

You will need to modify this configuration to suit your particular business requirements and adjust it to suit your
expected loads. For example, the default integration features automatic status annotations to the original event; in a
high-volume production system, this can significantly affect performance. Consider your expected volume of
injected events and your server capacity when designing your own integration with xMatters.

1.1.1 Benefits
With the xMatters integration, the appropriate technician can be notified directly via voice, email, pager,
BlackBerry, or other device. Information about the failure will be presented to the event resolver and decisions can
be made in real-time.

Once a response is selected on the recipient’s remote device, xMatters will update the HP Service Manager change
request in real-time. The benefit is that this process is immediate – significantly faster than the time required for staff
to notice the failures or malfunctions, determine who is on call, and manually notify the right person. In addition,
the ability to take simple actions on the event from any device gives the event resolver a quick way to deal with
many issues and communicate to other team members the current state of the event.

During the process, every notification, response, and action is logged in xMatters. In addition, xMatters
automatically annotates the original change request with status information.

The xMatters product features a self-service web user interface to allow accurate assignment of responsible personnel
for each job. xMatters also includes an optional enhanced Subscription panel that allows both managed and self-
subscription to HP Service Manager events. This Subscription panel queries the HP Service Manager server directly
in real time to retrieve lists of important settings and criteria, removing the need to create and maintain these lists.
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1.1.2 Information Workflow
The following diagram illustrates a standard workflow in a change request management system, and how information from
the management system is passed into the xMatters:

1.1.3 Integration architecture
The software components in this integration include:

l xMatters
l HP Service Manager Change Management
l xMatters integration agent

The following diagram illustrates the software processes used by this integration:
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Whenever HP Service Manager detects a problem, it triggers the following steps (for a description of what will cause an
event to be injected into xMatters, see "Event injection triggers", below):

1. HP Service Manager sends the event details to the xMatters integration agent via HTTP POST.
2. The integration agent forwards the event details to xMatters via web services.
3. The response returns to the integration agent.
4. The integration agent sends the response to HP Service Manager via web services.

User and Group synchronization process
As illustrated in the diagram, event injection for this integration is handled via the xMatters integration agent. User and
group synchronization, however, is handled via direct web service calls between xMatters and HP Service Manager. For the
user and group synchronization process to work, the Web Services User must be properly configured, as described in "Adding
the Web Service User" on page 16.

Event injection triggers
The following is a summary of the circumstances under which HP Service Manager will inject an event into xMatters for
notification. Note that this is the default, out-of-box behavior, and may be configured differently for some deployments.

l An event will be injected into xMatters whenever a new change request is created with a Priority of "Critical" or
"High".

l An event will be injected into xMatters whenever an existing change request with a Priority of "Critical" or "High" is
modified by upgrading the Priority, changing the Phase, or modifying the Assignee.

These events are untargeted events, used for subscriptions only.

An event will also be injected into xMatters when the Phase is changed to one that requires approval. At this point, the event
will be targeted to the approvers that are defined in the approval associated to the Change Phase in the Approvals section of
HP Service Manager; this is configurable within the HP Service Manager Client, and is specific to each customer's
implementation.

Note: The only time a targeted event is injected into xMatters is for approvals; all other events are untargeted.

1.2 System Requirements
The following component versions are supported by this integration.

Integration Component Version

xMatters 5.1 (patch 003 or later)

xMatters integration agent 5.1 (patch 003 or later)

HP Service Manager Change Management 9.3.4

For more information about the supported operating systems for xMatters, refer to the xMatters installation and
administration guide and xMatters integration agent guide

1.3 Conventions and Terminology
This section describes how styles are used in the document, and provides a list of definitions.
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1.3.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,
and then click the Open menu option.

Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:

l text that must be typed into the computer
l directory and file names
l code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute
the given paths with the Unix equivalents.

The xMatters installation folder is referred to throughout the documentation as <xMHOME>.

l On Windows systems, the default is C:\Program Files\xMatters
l On Unix systems, the default is /opt/xmatters

The xMatters integration agent installation folder is referred to throughout the documentation as <IAHOME>.

l On Windows systems, the default is C:\Program Files\xmatters\integrationagent
l On Unix systems, the default is /opt/xmatters/integrationagent

1.3.2 Terminology
The following terms are used through the xMatters documentation.

Term Meaning

Event An event refers to any situation or item of interest detected by the management system, and which
requires attention. Event is also used to refer to the incident or situation as it progresses through the
xMatters system, from injection to notification to resolution. Each event must generate at least one
alert or notification.

Event can also be a generic term used to refer to an incident, change request, message, or other
specific item within the management system. Whenever possible, these situations are referred to
using the management system's preferred terminology, but can also collectively be called events.

Management system A management system is any sort of monitoring or managing software that watches for events, and
with which xMatters can combine; i.e., a synonym for HP Service Manager.

Device The medium through which a recipient is contacted by xMatters; i.e., email, pager, phone,
BlackBerry, etc.

User In xMatters, people who can receive notifications are called "users". Each person in the xMatters
system is defined by a set of user details, including ID number, user name, login password, and so
on.

Group Groups are used to collect and organize users and devices into notification schedules. For a
complete explanation of Groups in xMatters, see the xMatters user guide.

Documentation terminology



xMatters for HP Service Manager Change Management

Chapter 2: Installation and Configuration | 5

Chapter 2: Installation and Configuration
This chapter provides information about installing the xMatters for HP Service Manager Change Management integration.
This chapter also contains complete instructions on how to configure xMatters, HP Service Manager, and the integration
components.

The instructions in this chapter do not include information on how to install xMatters, the xMatters integration agent, or HP
Service Manager. These components must be installed according to their related documentation, and operating properly
before you can proceed with the integration.

Note that in most cases, the xMatters integration agent must be installed on the same server as HP Service Manager.

Note: For more information about installing xMatters and other xMatters products, refer to the xMatters web site at
http:///www.xmatters.com.

2.1 Installing integration components
The following table describes some of the notable components in the integration archive file:

Component Name Description

xMattersSyncConfig.xml Contains all the groups, teams, users, devices and coverage value mappings
used when synchronizing HP Service Manager operators and assignments with
xMatters users and groups.

xMattersSyncList.xml Contains a list of all of the HP Service Manager operators and assignments to
either include or exclude from synchronization with xMatters.

xMattersForms.sc
xMattersScriptLibrary.sc
xMattersTriggers.sc xMattersUnload.sc
xMattersWebService.sc

HP Service Manager unload files used to import all the custom xMatters records
and tables.

XM-HP-SM-CM-3-0.xml Exported event domain file containing the event domain settings, predicates,
and constants required by the integration.

hpsmcm-3-0.js Contains the Javascript code to support the calls from HP Service Manager to
the integration agent when injecting events into xMatters.

hpsmcm.xml
configuration.js

Contains the configuration information for the integration agent.

Integration components

2.1.1 Installing the integration service
To install the integration service, you must perform the following steps:

l Copy the folder containing the integration components into the integration agent; this process is similar to patching the
application, where instead of copying files and folders one by one, you copy the contents of a single folder directly
into the integration agent folder (<IAHOME>). The folder structure is identical to the existing integration agent
installation, so copying the folder's contents automatically installs the required files to their appropriate locations.
Copying these files will not overwrite any existing integrations.

l Modify the integration agent's IAConfig.xml file to include the paths for the new integration services.
l Modify the variables in the configuration.js files associated with the integration services.
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If you have more than one integration agent providing the HP Service Manager service, repeat the following steps for each
one.

Note: If you have already installed an existing integration, ensure that you back up the deduplicator-filter.xml file
(if one exists) in the <IAHOME>\conf folder before you install this integration. 

To install the integration service:

1. Copy all of the contents of the \components\integration-agent folder from the extracted integration archive to the
<IAHOME> folder.

2. If you backed up an existing deduplicator file as indicated in the note above, merge the contents of your backup with
the newly installed <IAHOME>\conf\deduplicator-filter.xml file: open both files in a text editor, and then copy
the <filter> node from the backup file into the new deduplicator file after the last </filter> node. Save and close the
file.

3. Open the IAConfig.xml file found in <IAHOME>\conf and add the following line to the “service-configs” section:
<path>hpsmcm-3-0/hpsmcm-3-0.js</path>

4. Open the configuration.js file (now located in <IAHOME>\integrationservices\hpsmcm-3-0\ folder, and set
the values for the following variables:

Variable Description

HPSM_URL The URL of the HP Service Manager web service.

HPSM_USER_NAME The user name of the HP Service Manager web service user used to access the
web services.

HPSM_PASSWORD_FILE Location of the file containing the web service user's password; for instructions
on how to set the password for this user, see "Installing the integration
service", below.

DEDUPLICATOR_FILTER The name of the filter used to suppress duplicate notifications for this
integration. For more information, see "Filtering and suppression" on page 34.

DELETE_EXISTING_EVENTS Sends a "delete" prior to creating the new event, which will clear any existing
events for the incident ID.

ANNOTATE_DELIVERY Update HP Service Manager events with xMatters notification delivery status.

5. Restart the integration agent.
l On Windows, the integration agent runs as a Windows Service; on Linux, it runs as a daemon.

2.1.2 Installing voice files
These files must be installed into any xMatters deployment running a voice device engine. For more information, refer to the
xMatters installation and administration guide.

This integration provides two sets of English voice files; one for the notification integration, and one for the data load
portion.

To install the voice files:

1. Determine the value of the file identifier associated with your company.
l To find your company's file identifier, log into the xMatters web user interface as the Super Administrator, and
view the target Company's Details page (Admin tab > Companies > Company name).
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2. Copy the contents of the \components\xmatters\vox\ folder from the extracted integration archive to the following
node installs folder:

<xMHOME>\node\phone-engine\Datastore\<FILE_IDENTIFIER>\

For example, if you were installing the integration for the default company on an out-of-the-box deployment, the installation
path for the voice file would be as follows:
<xMHOME>\node\phone-engine\Datastore\1\hpsmcm-3-0\recordings\english\phrases

Note that if this is the first custom event domain you have created, the <FILE_IDENTIFIER> directory will not have been
created yet. You can create it manually or log into xMatters and use the web user interface to add a new voice recording. If
the phone device engine is running, xMatters will create the directory structure and place the new voice recording in it.

2.1.3 Installing the web services library
To enable web service calls between xMatters and HP Service Manager, you must copy the JAR file from the lib folder in
the extracted integration archive into the web server library folder.

Source file:
\components\xmatters\lib\com.alarmpoint.servicemanager.cm.jar

Web server destination directory:
<xMHOME>\webserver\webapps\cocoon\WEB-INF\lib

Note: If you have installed more than one web server, copy the JAR file into the destination directories on each one.

2.1.4 Installing the synchronization configuration files
The xMattersSyncConfig.xml and xMattersSyncList.xml files contain the configuration information for synchronizing
users, groups, devices and coverages from HP Service Manager into xMatters.

Note that the synchronization process and all its files are identical for both the HP Service Manager Change Management and
the HP Service Manager Incident Management integrations; if you have already installed the HP Service Manager Incident
Management integration (version 3.0), you can skip this step.

To install the synchronization configuration files:

Copy the files in the \components\servicemanager\config\ folder from the extracted integration archive to <SMHOME>.

Note: If these files are installed to a different location, you must modify the AlarmPointConfig script library within HP
Service Manager.

2.2 Configuring HP Service Manager
Configuring HP Service Manager to combine with xMatters requires the following steps:

n Import the xMatters tables and records.
n Modify the HP Service Manager triggers.
n Modify the AlarmPointConfig script.
n Add the SOAP API and xMatters capabilities to HP Service Manager User for xMatters web service calls.
n Update the IM.template.update and IM.update.incident forms to allow web service calls to update change requests.
n Expose the problem.type and product.type tables for web service calls.
n Remove the invalid data from HP Service Manager categories.
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n Add the syncContact call to the createUser 2 Wizard.
n Enable Resolve for Web Services.

2.2.1 Importing xMatters tables, records, and web services
The xMatters tables, records, and web services are used to inject change requests to xMatters for notification, and required by
the HP Service Manager database for the integration.

The .sc files described in this section are shared between both HP Service Manager integrations; if you have already installed
the HP Service Manager Incident Management integration (version 3.0), you should skip this step.

To import the tables, records, and web services:

1. Log in to the HP Service Manager Client Console.
2. Open the Administration perspective.
3. In the System Navigator, open the Tailoring folder, and then double-click the Database Manager object.
4. In the drop-down menu in the upper-right corner of the main object window, select Import/Load.
5. Click the folder icon beside the File Name field.
6. Select the first .sc file in the \components\servicemanager\imports\ directory, in the extracted integration

archive.
7. Click Open.
8. Click Load FG.

Repeat the above steps for each of the remaining .sc files in the imports directory.

Service Manager Unload scripts
This integration includes a set of HP Service Manager unload scripts intended to help with the maintenance of the
integration. The unload scripts are:

l AlarmPoint Forms: This script unloads all the capability words, dbdict definitions, displayoptions, displayscreens,
formats, globallists, menus and scripts associated with the integration.

l AlarmPoint Integration: This unload script is a combination of the Forms, ScriptLibrary, Triggers, Unload and Web
Services unload scripts.

l AlarmPoint Purge: This unload script is similar to Integration, but instead of an unload this script performs a purge
l AlarmPoint ScriptLibrary: This unload script unloads the xMatters Java Scripts found in Script Library
l AlarmPoint Triggers: This unload script unloads the xMatters triggers associated with the integration.
l AlarmPoint Unload: This unload script unloads the unload scripts.
l AlarmPoint Web Services: This unload script unloads the External Access Definitions needed as part of the integration.
Note that this does not unload a comprehensive list of the External Access Definitions that are required; it is an unload
of the definitions which are unique to the integration and created to support the integration. Definitions such as
IncidentManagement, which are updated to support the integration, must be managed manually.

2.2.2 Modifying the HP Service Manager triggers
Importing the xMattersTriggers.sc file loads all of the triggers for both of the xMatters for HP Service Manager
integrations. If you want only the HP Service Manager Change Management integration (i.e., you are not installing the HP
Service Manager Incident Management integration), you should delete the triggers specific to the other integration.



xMatters for HP Service Manager Change Management

Chapter 2: Installation and Configuration | 9

To delete the triggers:

1. In the HP Service Manager Database Manager's Form field, type triggers, and then press Enter.
2. In the Trigger Name field, type alarmpoint and then press Enter.
3. Locate and delete the following triggers:

l alarmpoint.after.add.probsummary
l alarmpoint.after.update.probsummary

2.2.3 Modifying the AlarmPointConfig script
The AlarmPointConfig script contains configuration information for web services, data synchronization, and other parameters
as described in the table below. This section describes how to modify the configuration script to allow HP Service Manager
to inject change requests to xMatters through web services.

Note: The configuration files described in this section are shared between both HP Service Manager integrations; if you
have already installed the HP Service Manager Incident Management integration (version 3.0), you can skip this
step.

To modify the AlarmPointConfig script:

1. In HP Service Manager System Navigator, open the Tailoring folder, and then double-click the Script Library object.
2. In the Name field type AlarmPointConfig, click Search.
3. Modify the variables in the following table to suit the configuration of your integration.
4. Click Save, Compile, and then Execute.

l If HP Service Manager returns any errors after you click Compile, ensure that you have updated the file correctly.

Variable Name Value

web_service_url The URL of the xMatters web service; for example:
"http://localhost:8888/api/services/AlarmPointWebService";

web_service_user The user name of the xMatters Web Service User (as configured in "Adding
the Web Service User" on page 16). Best practices suggest that the user name
be related to the purpose; e.g., "hpsm-xmwsu".

web_service_password The password of the xMatters Web Service User.

xmatters_servicemanager_cm_domain The name of the xMatters Event Domain for Change Manager notifications.

default_xmatters_admin_group The target name of the recipient (group or user) in xMatters where
synchronization error notifications are sent. This group is created in "Creating
a fail-safe Group" on page 19.

Note: If a group has a synchronization error and that group has a supervisor,
the group supervisor will be notified instead of this recipient.

send_sync_error_notifications If true, sends notifications to the default administration group created in
"Creating an Admin Group" on page 20 (or the group supervisor) when a
record fails to synchronize with xMatters.

AlarmPointConfig script variables
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Variable Name Value

xmatters_servicemanager_sync_domain The xMatters event domain for Service Manager. The value initializes the
variable using an existing variable value, and should not include quotes.

Note: If you are installing ONLY the HP Service Manager Change
Management integration, change the variable name to:
xmatters_servicemanager_cm_domain

sm_home The location of the HP Service Manager installation; for example:

"C:\\Program Files (x86)\\HP\\Service Manager 9.30\\Server\\"

config_file The location of the xMattersSyncConfig.xml; for example:
sm_home + "xMattersSyncConfig.xml"

synclist_file The location of the xMattersSyncList.xml; for example:
sm_home + "xMattersSyncList.xml"

ia_url The URL of the integration agent HTTP listener; for example,
http://localhost:2010/agent

Note: If the integration agent is installed on the same computer as HP Service
Manager, you do not need to modify this parameter.

xmatters_company Name of the company within xMatters; the default value is “Default
Company”.

sync_voice If true, voice devices will be synchronized; the default is true.

detailedSyncLogging If true, displays filtering information when performing a synchronization;
default is true.

detailEventLogging If true, displays the APXML being sent to xMatters; default is false.

sync_cm3groups If true, synchronize HP Service Manager Change groups when performing a
synchronization; default is true.

sync_assignmentGroups If true, synchronize HP Service Manager Assignment groups; default is true.

assignmentGroupSuffix Specifies the string to add to the end of HP Service Manager Assignment
group names when synchronizing.

Note: This suffix prevents possible name collisions between Assignment and
Change groups, which can have the same name in HP Service Manager, but
must have unique names in xMatters.

changeGroupSuffix Specifies the string to add to the end of HP Service Manager Change group
names when synchronizing. (See note above for more information)

2.2.4 Adding capabilities to users
The integration requires all users who are going to respond to notifications through xMatters to have both the "SOAP API"
and "AlarmPoint" capabilities in addition to the appropriate xMatters configuration as described in "Configuring Users" on
page 16. These users can update and annotate HP Service Manager change requests from xMatters through web service calls.
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To add the required capabilities to a user:

1. In the HP Service Manager System Navigator pane, expand the System Administration > Ongoing Maintenance
folders, and then double-click the Operators item.

2. In the Login Name field, type the login name of the user to whom you want to give response capabilities, and then
click Search.

l The default configuration of the xMatters Action Scripts uses the default HP Service Manager user “falcon” to
make web service calls; if you want to use a different user, you must update the Action Scripts accordingly. For
more information, see “Configuration Variable Reference” on page 54.

3. Select the Startup tab.
4. Under Execute Capabilities, if not already listed, add SOAP API and AlarmPoint.
5. Click Save.

xMatters may now use web service calls to connect to this HP Service Manager user.

2.2.5 Add the syncContact call to the createUser 2 Wizard
The AlarmPointUser.syncContact call must be added to the createUser 2 Wizard to enable synchronization of users upon their
creation.

Note that while HP Service Manager’s User Quick Add Utility has space for both first and last names, the xMatters
synchronization parses the first word (up to the first space) within the Full Name field as the first name, and adds any
remaining words to the last name. For example, if a user was added in HP Service Manager with a first name of “One Two”
and a last name of “Three Four”, xMatters would parse the entry as first name “One” and last name “Two Three Four”.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To add the syncContact call:

1. In the HP Service Manager System Navigator pane, in the Tailoring folder, double-click Wizards.
2. In the Wizard Name field, type createUser 2 (case sensitive), and then click Search.
3. Click the Actions tab, and then click the Javascript tab.
4. Add the following line to the end of the Javascript:
system.library.AlarmPointUser.syncContact(vars.$contactname);

5. Click Save.

Now when a user is created in HP Service Manager using the createUser 2 Wizard, they will be automatically synchronized
with xMatters.

Note that in HP Service Manager, Login IDs are case sensitive; for example, “FALCON” and “falcon” represent two separate
users. In xMatters, User IDs (the equivalent to Login IDs in HP Service Manager) are case insensitive: xMatters would not
recognize “FALCON” and “falcon” as belonging to different Users.

2.2.6 Adding the syncContact call to the Process record
For the contact.do.save call to properly synchronize user information with xMatters, the AlarmPointUser.syncUser call must
also be added to the Process record.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.
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To add the syncContact call:

1. In the HP Service Manager System Navigator pane, click Tailoring > Database Manager.
2. In the Table field, type Process, and then click the Search button.
3. On the Process Definition form, in the Process Name field, type contacts.do.save, and then click the Search button.
4. Click the Final JavaScript tab.
5. Add the following line to the JavaScript:
system.library.AlarmPointUser.syncUser(record, oldrecord);

6. Click Save.

2.3 Configuring xMatters
Configuring xMatters to combine with HP Service Manager Change Management requires the following steps:

l Import the event domain, and configure the integration service and event domain constants for each
l Configure the default user
l Add or configure a Web Services user
l Create a subscription (optional)

2.3.1 Importing Event Domain
The integration package includes an XML file that was created using the xMatters "Export Integration" feature; this greatly
simplifies the xMatters configuration process by enabling you to create the integration event domain, configure the predicates
and event domain constants, and import the integration script package in a single step.

To import the Event Domain packages:

1. Log in to xMatters as a Company Administrator, and click the Developer tab.
2. On the Event Domains page, click Import New.
3. On the Import Integration page, click Browse, and then locate the \components\xmatters\event-domain\XM-HP-

SM-CM-3-0.xml file extracted from the integration archive.
4. Click Open, and then click Upload.

xMatters imports the integration configuration settings and displays the new "hpsmcm-3-0" event domain. xMatters also
creates the predicates for the event domains, and assigns common values as defaults.

Defining the integration service
For the installation to be successful, the integration service names must match the names specified in the hpsmcm.xml file
installed on the integration agent.

To define an Integration Service:

1. In xMatters, on the Event domains page, click the hpsmcm-3-0 Event Domain.
2. On the Event Domain Details page, in the Integration Services area, click Add New.
3. Enter the following information into the form:

l Name: hpsmcm-3-0
l Description: HP Service Manager Integration Service
l Path: Not required.

4. Click Save.
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Specifying connection parameters
Once you have imported the event domain packages and configured the integration services, you must specify an xMatters
address that is reachable from within a notification so that responses can be processed, and other values for the event domain
constants.

Note: A known issue in xMatters version 5.0 requires that all Event Domain Constants be defined in UPPERCASE.

To specify the connection constants:

1. On the Event Domains page, in the Domains menu, click Event Domain Constants.
2. In the Event Domain drop-down list, select hpsmcm-3-0, and then click Continue.

l xMatters displays the pre-configured event domain constants for the integration.
3. In the event domain constants list, specify the correct values for the following constants (click the name of a constant

to edit its value and description).

Note: Shaded rows indicate mandatory settings that are specific to your deployment. You must change the default settings
to match your instance.

Constant Name Default Value Description

XMATTERSURL http://localhost:8888 Used to specify the address of the
xMatters web server. The links
provided in notification content use
this value to locate the xMatters web
server which would process the
response. For these links to work, this
address must be reachable from the
device where the user will receive the
notification; normally, this is the
IP address or fully-qualified host name
of the xMatters web server.

BESPUSHURL http://localhost:8888/static Used to specify the address of the BES
device server.

ENFORCECUSTOMFIELDS true If true, allow replies only if user's
custom fields set.

Note: Not all operations succeed if
user's custom fields not set.

HPSMLOGINCUSTOMFIELD HP SM Login Specifies the name of the custom field
that stores the user name for each user
accessing HP Service Manager.

HPSMPASSWORDCUSTOMFIELD HP SM Password Specifies the name of the custom field
that stores the user password for each
user accessing HP Service Manager.

Event Domain Constants
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Constant Name Default Value Description

USEDEFAULTCREDENTIALS false Determines whether to use:

l the user's custom credentials (the
contents of the HP SM Login
and HP SM Password custom
fields); or,

l the default HP Service Manager
credentials provided in the
integration agent configuration
when interacting with HP
Service Manager (for example,
for annotating responses).

FORCEFYI disable Force notifications to be information
only (FYI), rather than requiring
responses.

Note: This overrides the FYI behavior
specified on the injected event.

l disable: nothing is forced
l on: notifications are forced to be
FYI

l off: notifications are forced not
to be FYI

FAILSAFEGROUP HPSMCM FailSafe The failsafe recipient to notify,
typically a group.

FAILSAFE enabled Controls failsafe functionality,
notifying the failsafe recipient via
EMAIL under certain circumstances:

l enabled: notify if no
subscriptions match or no
notifiable recipients

l for-subscriptions: notify if
subscription functionality is
enabled and no subscriptions
match

l for-recipients: notify if no
notifiable recipients

l disabled: disable failsafe
functionality

OVERRIDETIMEFRAMES false Override recipients device time frames.

USEEMERGENCYDEVICES false Force the use of emergency devices.
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Constant Name Default Value Description

TRACKDELIVERY true Track when each device is delivered
to.

Note: Setting this to false may give a
performance advantage, but you lose
any information about whether a
delivery was successful or not.

ANNOTATE true Enables submission of annotations
back to the management system.

SUBSCRIPTIONANNOTATE false Enables submission of subscription
annotations back to the management
system.

TRACKSUBSCRIPTIONDELIVERY false Track when each device is delivered to
for subscriptions.

TIMEOUT 259200 Amount of time (in seconds) the event
is allowed to run before timing out.

MAXINVALIDRESPONSES 3 Specifies the maximum invalid
responses allowed before notification
is no longer re-queued.

ENABLEHTMLEMAIL true Enables HTML email functionality.

USELOGO true Set this if you want the logo displayed
within HTML email notifications.

NUMERICPAGENUMBER 555-1212 The numeric pager content is set to a
non-existent phone number.

Note: For event call-in, this number
should be changed to a real call-in
number, or a message indicating an
xMatters event notification has
occurred.

DEBUG false Indicates whether to log informational
messages for debugging purposes.

Note: You may want to disable this
behavior to improve performance.

2.3.2 Defining Custom Fields
This integration uses custom fields defined in xMatters to obtain authentication credentials for submitting notification
responses and annotations to HP Service Manager. These custom fields enable the response option list to be displayed on
notifications.

By default, the custom fields are “HP SM Login” and “HP SM Password”; it is strongly recommended that you use these
default field names.
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Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To define the custom fields:

1. In xMatters, click the Admin tab, and then, in the Administration menu on the left side of the screen, click Custom
Fields.

2. Click Add New, and then enter the following information into the form:
l Field Name: HP SM Login
l Type: Text

3. Click Save.
4. Click Add New, and then enter the following information into the form:

l Field Name: HP SM Password
l Type: Password

5. Click Save.

Note: For more information about custom fields, see the xMatters installation and administration guide.

2.3.3 Configuring Users
Each xMatters User that will be notified and respond to notifications must be configured to allow xMatters to communicate
with HP Service Manager as that User. Note that each User must also be configured in HP Service Manager, as described in
"Adding capabilities to users" on page 10.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To configure a User:

1. In xMatters, click the Users tab.
2. Use the Find Users page to locate the user you want to configure and view their details.
3. In the Common Tasks pane, click User Devices.
4. Verify that an appropriate device exists and that it is enabled.
5. Click Save.

Note: If you have no users in the system, you can use the default demonstration user, "bsmith". If this user does not exist,
create a user with the User ID “bsmith”, and add a virtual text phone device. For more information and
instructions on how to perform these tasks, refer to the xMatters user guide.

2.3.4 Adding the Web Service User
This integration requires a Web Service User for the HP Service Manager events to be injected to xMatters using web
services, and for the user and group synchronization process to communicate via web service calls.

The xMatters Web Service User must have the same User ID and Password that you configured within the AlarmPointConfig
script; for more information, see "Modifying the AlarmPointConfig script" on page 9.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.
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To set up a Web Service User:

1. In xMatters, click the Users tab, and then click Add Web Service User.
2. Enter the following information into the form:

l User ID: hpsm-apwsu
l Description: HP Service Manager - xMatters Web Service User
l Password: type the User’s password (default is password)
l Verify Password: retype the password to verify it.

3. Add the following web services to the Allowed Web Services list:
l Add Coverage
l Add Device
l Add Group
l Add Team
l Add User
l Delete Coverage
l Delete Device
l Delete Group
l Delete Incident
l Delete Team
l Delete User
l Find Devices
l Find Groups
l Find Persons
l Find Who Is On Duty
l List Group Members
l Query Group
l Query User
l Update Coverage
l Update Device
l Update Group
l Update Team
l Update User

4. Click Save.

Note: The User ID and Password for the Web Service User must match the web_service_user and web_service_password
defined in "Modifying the AlarmPointConfig script" on page 9.

2.3.5 Subscribing to Alerts
You can use the subscriptions feature in xMatters to subscribe to HP Service Manager change requests that match specific
criteria. For example, you could configure a subscription that would send an informational notification to a specific user each
time an event entered the system that was of "Immediate" urgency, or whenever an event's status was changed to "Resolved".
These notifications, and their responses, do not affect the normal progression of an event through the system.

To allow users to subscribe to specific criteria on injected events, you must configure the subscription using the following
steps:



xMatters for HP Service Manager Change Management

Chapter 2: Installation and Configuration | 18

n Define a subscription domain
n Create a subscription
n Create a fail-safe group

Defining a subscription domain
The subscription domain allows you to control who can create subscriptions, how recipients can respond to subscription
notifications, and which event domain predicates can be used to create a subscription. You must create a subscription domain
before you can create subscriptions.

To create a subscription Ddmain:

1. On the Developer tab, in the Developer menu, click Subscription Domains.
2. On the Subscription Domains page, click Add New.
3. In the Event Domain drop-down list, select hpsmcm-3-0, and then click Continue.
4. On the Subscription Domain Details page, in the Name field, type HP Service Manager CM.
5. Select the One-Way check box.

l Set the Custom Page URL to jsp\subscription\hpsmcm-3-0\SMCMSubscriptionForm.jsp.
l For this integration, responses are dynamically created for each notification; this makes defining precise response
choices very difficult. It is recommended that you create only One-Way Subscriptions for this integration.

6. Click Continue.
7. On the Select Appropriate Predicates page, add all of the predicates to the Applied Predicates list, and then click

Continue.
8. On the Select Roles page, specify the roles you want to be able to create subscriptions on the domain, and then click

Save.

For more information about working with event and subscription domains, see the xMatters installation and administration
guide.

Configuring the Subscription JSP
You can use either of the following methods to populate the predicate list values on the Subscription Panel:

n Manually specify the predicate list values in the web user interface.
n Using web services, query HP Service Manager for possible values, and automatically populate the predicate lists with

the results of the web service call.

Note: Changing Subscriptions by adding or removing Event Domain predicates may cause existing Subscriptions to fail.
For more information about working with Event and Subscription Domains, see the xMatters installation and
administration guide.

Specifying predicate lists manually

To configure the Subscription panel in a demo mode, using predefined predicate list values, you must modify the
Subscription JSP.

To manually populate the predicate lists:

1. Open the <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\hpsmcm-3-0\SMCMConfig.jsp
file in a text editor.

2. Set the Boolean variable QUERY_PREDICATE_VALUES to false.
3. Save and close the JSP file.
4. In xMatters, click the Developer tab.
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5. On the Event Domains page, click hpsmcm-3-0.
6. On the Event Domain Details page, in the Predicates list, click the name of the predicate for which you want to define

the values.
7. Add to the predicate list values, and then click Save.
8. Repeat steps 6 and 7 for each predicate to which you want to assign values.

The predicate lists on the Subscription will now be populated with the predefined list values instead of the web service call
results.

Populating predicate lists automatically

If you want to populate the predicate values lists from HP Service Manager through web service calls rather than the
predefined predicate list values, you must configure the connection properties within the JSP file.

To configure the Subscription JSP to connect through web services:

1. Open the <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\hpsmcm-3-0\SMCMConfig.jsp
file in a text editor.

2. Within the Subscription JSP, locate the following section:
final String SERVICE_MANAGER_URL = "http://localhost:13080/sc62server/ws";
final String SERVICE_MANAGER_USER = "falcon";
final String SERVICE_MANAGER_PASSWORD = "";

3. Replace the value within quotes for each parameter as described in the following table:

Parameter Value

SERVICE_MANAGER_URL The URL for the HP Service Manager web services.

SERVICE_MANAGER_USER User name of the HP Service Manager Web Services User.

SERVICE_MANAGER_PASSWORD Password for the HP Service Manager Web Services User.

Subscription JSP parameters

4. Set QUERY_PREDICATE_VALUES to true.
5. Save and close the JSP.

Creating a subscription
You can use the subscriptions feature in xMatters to subscribe to HP Service Manager events that match specific criteria. For
example, you could configure a subscription that would send an informational notification to a specific user each time an
event entered the system that was of "Immediate" urgency, or whenever an event's status was changed to "Resolved". These
notifications, and their responses, do not affect the normal progression of an event through the system.

To create a subscription:

1. On the Alerts tab, in the Alerts menu, click My Subscribed Alerts. Select the HP Service Manager CM subscription
domain, and click the Add New link.

2. On the Subscription Details page, specify a name for the subscription, and set the subscription criteria using the tabs.
3. When you are satisfied with the criteria, click Save to create the subscription.

Creating a fail-safe Group
If an event is submitted to xMatters when the fail-safe functionality is enabled, and there is no device or user that matches the
event, xMatters sends the notification to the fail-safe recipient. The fail-safe recipient is typically a group, but can be
configured as a user.
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To create a fail-safe Group:

1. In xMatters, click the Groups tab.
2. Create a new group named HPSMCM FailSafe, with at least one user as a team member to receive notifications.

For more information about creating groups and teams, see the xMatters user guide.

2.3.6 Creating an Admin Group
If a synchronization error occurs and the send_sync_error_notification configuration variable is set to true in the
AlarmPointConfig script, then a notification is sent out to the recipient defined in the default_xmatters_admin_group variable
in the AlarmPointConfig script. The default value is set to "companyadmin".

l If you do not want notifications to be sent out due to synchronization errors, set the send_sync_error_notification
variable in the AlarmPointConfig script to false.

To configure the HP Service Manager Admin Group, click the Groups tab in xMatters, and create a new group named SM
Admin, with at least one user as a team member to receive notifications. Update the default_xmatters_admin_group variable
in the AlarmPointConfig script with the name of the new Group.

Note that if you have already installed the HP Service Manager Incident Management integration, you do not need to do this
step.

Note: For more information about creating groups and teams, see the xMatters user guide.

2.4 Configuring Synchronizations
The xMatters for HP Service Manager Change Management integration supports one-way synchronization of groups (both
assignment and change groups in HP Service Manager), teams, users, devices and coverages from HP Service Manager into
xMatters. To enable synchronization and customize it to your business behavior, two configuration files are provided:
xMattersSyncConfig.xml and xMattersSyncList.xml.

Modify these files according to your desired business behavior; the following sections provide an overview of these files and
their configuration options.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

Synchronization Troubleshooting
When performing a synchronization, open the HP Service Manager messages panel. This allows you to see successful
completion of synchronizations such as modifying groups, group memberships, users, and user devices. Alternatively, you can
use the Sync Report under the Menu Navigation xMatters entry to determine if any errors occurred after synchronization.

2.4.1 Synchronization configuration file
The xMattersSyncConfig.xml file defines the synchronized values for groups, teams, users, devices and coverages. The file
included with the integration has default values to use for each object type, but can be customized to use different values for
a specific instance of an object.

Note that in HP Service Manager, Login IDs are case sensitive; for example, “FALCON” and “falcon” represent two separate
users. In xMatters, User IDs (the equivalent to Login IDs in HP Service Manager) are case insensitive: xMatters would not
recognize “FALCON” and “falcon” as belonging to different users.
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Note: If have already installed the HP Service Manager Incident Management integration, you do not need to perform
this step.

Default values
Each default element must specify a value for all possible fields (refer to the following section for a complete list of possible
fields). Each default element must also specify the seedOnly and deletable attributes.

If the seedOnly attribute is true, then that object will only be added to xMatters when it is initially synchronized and will no
longer be updated. If the seedOnly attribute is false, any modifications to the object done in xMatters will be overwritten
when that object is updated in HP Service Manager.

If the deletable attribute is true, then that object will be removed from xMatters when it is deleted from HP Service Manager;
otherwise, it will remain in xMatters indefinitely and must be deleted manually.

The following elements must exist in the xMattersSyncConfig.xml file:

l default-user
l default-email
l default-work-phone
l default-home-phone
l default-sms-phone
l default-assignment-group
l default-change-group
l default-team
l default-coverage

By default, all objects are deletable and set to seedOnly = false.

There are three different ways that you can specify a default value to synchronize with xMatters:

1. Set a default value for a field:
l default: the value for this field

For example, the role for the following will be standard user unless it is overridden:
<role default="standard user"/>

2. Use a regular expression to extract a value from a field:
l default: the default value for this field if the regular expression does not match
l field: the column in this table to apply the regular expression
l regex: the regular expression used to extract a value
l index: when you use Groups, this is the index of the Group you want to use (where the first Group is 1)

For example, the area-code for the following will be the first submatch when the '\D*(\d{0,3})\D*([0-9]{1}[0-9., -]+)\D*'
regular expression is applied to the contact_phone field
<area-code field="contact_phone" regex="\D*(\d{0,3})\D*([0-9]{1}[0-9., -]+)\D*" index="1"/>

3. Map a field’s value to a desired value:
l default: the default value to use if there is no match
l map Element: the field attribute specifies the column in the table to match; the value attribute specifies the value
of the field to match on; and, the text of this field is the value to be saved

For example, the language for the following will be English, unless the value of the language column in the record is either
de or fr:
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<language default="English">
<map field="language" value="de">German</map>
<map field="language" value="fr">French</map>

</language>

Object-specific values
All object-specific elements will override any default value element and can override the seedOnly and deletable attributes.

Field Description Possible Values

active Whether this user is active true, false

first-name User’s first name Any string

last-name User’s last name Any string

has-mobile-access Mobile access flag true, false

site User’s site Valid xMatters Site name

language User’s language Valid xMatters language

timezone User’s time zone Valid xMatters time zone

role User’s xMatters role A comma-delimited list of valid xMatters roles.

supervisor User’s xMatters supervisor Valid xMatters User target name. If the
supervisor in HP Service Manager is not a valid
User in xMatters, the synchronization for the
User/Group will fail.

has-phone-login Phone login flag true, false

phone-login User’s phone login Unique string containing only digits

phone-password User’s phone password String containing only digits

ldap-domain User’s web login LDAP domain Valid xMatters LDAP domain

web-login User’s web login Unique web login

web-password User’s web login password Any string

web-login-type Defines whether the web login is a
native xMatters login or an LDAP
authentication

NATIVE, LDAP

externally-owned Indicates whether the user is externally-
owned

true, false

custom-field-name The name of the Custom Field in
xMatters that will contain the value of
SM userId to be used by xMatters
notification responses.

Any string. Default is “HP SM Login”

custom-field-value The value to use in the Custom Field
defined in the custom-field-name field.

Any string

default-user Fields
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Field Description Possible Values

name Device name (must match a device name configured in
xMatters)

Valid xMatters email device
name

active Whether this device is active (i.e., available to receive
notifications.

true, false

default Whether this device should be used as the user’s default
device

true, false

delay Device’s delay setting Integer value (time in
minutes)

externally-owned Indicates whether the device is externally-owned true, false

priority-threshold Device’s priority threshold LOW, MEDIUM, HIGH

user-service-provider-id ID of the User Service Provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name Name of the User Service Provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

address Device’s email address Valid email address

default-email Fields

Field Description Possible Values

name Device name (must match a device name configured in
xMatters)

Valid xMatters email device
name

active Whether this device is active true, false

default Whether this device should be used as the user’s default
device

true, false

delay Device’s delay setting Integer (time in minutes)

externally-owned Indicates whether the device is externally-owned true, false

priority-threshold Device’s priority threshold LOW, MEDIUM, HIGH

user-service-provider-id ID of the User Service Provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name Name of the User Service Provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

area-code Device’s area code String containing only digits

country-code-override Device’s county code Valid two letter country code

extension Device’s extension String containing only digits

number Device’s phone number String matching [0-9]{1}[0-9.,
-]+

default-work-phone, default-home-phone, and default-mobile-phone Fields
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Field Description Possible Values

name Device name (must match a device name configured in
xMatters)

Valid xMatters email Device
name

active Whether this device is active true, false

default Whether this device should be used as the user’s default
device

true, false

delay Device’s delay setting Integer (time in minutes)

externally-owned Indicates whether the device is externally-owned true, false

priority-threshold Device’s priority threshold LOW, MEDIUM, HIGH

user-service-provider-id ID of the User Service Provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name Name of the User Service Provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

number Device’s phone number String containing only digits

default-sms-phone Fields

Field Description Possible Values

description Group’s description Any string

timezone Group’s time zone Valid xMatters time zone

site Group’s Site Valid xMatters Site

active Whether this group is active true, false

allow-duplicates Allow duplicates flag true, false

externally-owned Externally owned flag true, false

observed-by-all Observed by all flag true, false

observer Target name of a user to be the group’s observer Valid xMatters user target name

supervisor Target name of a user to be the group’s supervisor Valid xMatters user target name

use-default-device Use default device flag true, false

default-assignment-group and default-change-group Fields

Field Description Possible Values

name Team name Any string not containing ‘|’

description Description for the team Any string

default-team Fields
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Field Description Possible Values

externally-owned Externally owned flag true, false

reuse Reuse team flag true, false

rotation-interval Rotation interval (only used if type is ROTATION) Integer value (time in minutes)

rotation-start Rotation start date (only used if type is
ROTATION)

Date in the format

‘dd/mm/yyyy h:mm:ss AM/PM’

rotation-unit Rotation units (only used if type is ROTATION) DAYS, MONTHS, WEEKS

type Team type BASIC, EVENT_ROUND_ROBIN,
ROTATION

member-type Team member type (should leave as PERSON for
the integration)

PERSON, GROUP, TEAM, DEVICE

member-delay Delay between team members Integer value

member-in-rotation Are group members in the rotation true, false

Field Description Possible Values

name Coverage name 24/7 Any string not containing '|'

start-time Start time for this shift Time in the format "hh:mm"

duration-hours Duration of the shift in hours Integer value 0 <= N <= 24

duration-minutes Duration of the shift in minutes (added to duration in
hours)

Integer value 0 <= N <= 60

exclude-holidays Exclude holidays flag true, false

sunday Coverage on Sunday true, false

monday Coverage on Monday true, false

tuesday Coverage on Tuesday true, false

wednesday Coverage on Wednesday true, false

thursday Coverage on Thursday true, false

friday Coverage on Friday true, false

saturday Coverage on Saturday true, false

recurrence-end-date End date for the coverage Time in the format

dd/mm/yyyy h:mm:ss AM/PM

recurrence-frequency Frequency of the recurrence DAILY, WEEKLY,
MONTHLY

default-coverage Fields
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Field Description Possible Values

recurrence-interval Interval of the recurrence Integer value

recurrence-no-end-date No end date flag true, false

recurrence-occurences Number of recurrences for this coverage Integer value

recurrence-start-date Start date of the recurrence Time in the format

dd/mm/yyyy h:mm:ss AM/PM

2.4.2 Synchronization list file
The xMattersSyncList.xml file is used to define which operators and assignments should be synchronized with xMatters.
The XML file contains a list of user elements with a name attribute matching an operator ID and a list of group elements
containing a name attribute matching an assignment name.

The user and group elements have an action attribute which tells the integration whether you want to include only the user
and group in the list for synchronization and exclude all other users and groups, or whether you want to exclude the user and
group in the list for synchronization and include everyone else. The following is an example of what the file would look like
if you want to synchronize only the TELECOMS assignment and want to synchronize all the operators except for FALCON:
<synclist>
<users action="exclude">
<user name="FALCON"/>

</users>
<groups action="include">
<group name="TELECOMS"/>

</groups>
</synclist>

2.5 Configuring the Sync Report form
This integration includes the custom HP Service Manager Sync Report form.

The Sync Report can begin full system synchronization and view the last status of objects synchronized with xMatters. The
behavior of the page is as follows:

l Click Show Errors to display all synchronization records that are currently in an error state.
l Click Show All to display all synchronization records.
l Select Sync Now to initiate an attempt to synchronize the entire system.
l Click Filter to display all synchronization records that match the specified filter criteria. These filter fields use the
StartsWith operator.

2.5.1 Adding buttons and menus to the Sync Report form
The alarmpoint.syncreport scripts provided with the integration can be used with the script.execute RAD application.

To add menu items:

1. In Service Manager, open Menu Navigation > Tailoring > Tailoring Tools > Menus.
2. In the Menu Name field, type the name of the appropriate menu for your deployment (e.g., HOME), and then click

Search.
3. Add the following values to the table:
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Option Number Description Application Parameter Value Condition

Next available
number

xMatters menu.manager name AlarmPoint
MAIN

index("AlarmPoint",
$lo.ucapex)>0

Note: Ensure that you record the Option Number assigned to each button and menu, as you will need to reference these
numbers when adding the custom form buttons in the next section.

4. Click Save, and then click Save again.
l If you receive an error message after clicking Save the first time, you can safely ignore it.

5. Refresh the System Navigator.

You should now see a new xMatters navigation group in the System Navigator with separate entries for each custom form.

Note: The buttons and menu items are visible only to users with the "AlarmPoint" capability. For information about how
to add the capability, refer to "Adding capabilities to users" on page 10.
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Chapter 3: Integration Validation
After configuring xMatters and HP Service Manager, you can validate that communication is properly configured. It
is recommended that you start the components in the following order:

l HP Service Manager Change Management
l xMatters
l xMatters integration agent

Consult the respective user manuals for details on starting these applications.

The following sections will test the combination of xMatters and HP Service Manager for notification delivery and
response, subscription functionality, and synchronization configuration.

3.1 Validating User and Group Synchronization
The following validates that communication from HP Service Manager to xMatters for user and group
synchronization is properly configured.

Note that the user and group synchronization process is handled via direct web service calls between xMatters and
HP Service Manager; synchronization relies upon the correct configuration of the web services user, as described in
"Adding the Web Service User" on page 16

To test the User and Group Synchronization:

1. Edit the <SMHOME>\xMattersSyncList.xml file as follows:
<synclist>
<users action="include">
</users>
<groups action="include">
</groups>

</synclist>

2. Restart your HP Service Manager client.
3. Add a new Operator to HP Service Manager:

l In HP Service Manager, open Menu Navigation > System Administration > Ongoing Maintenance >
User Quick Add Utility.

l Specify the required information.
l Click Next, Finish, and then OK.

4. In HP Service Manager, open Menu Navigation > System Administration > Ongoing Maintenance > Groups
> Incident Management Assignment Groups.

5. Type the name of the assignment group you want to use for testing purposes (eg. TESTSYNC).
6. Select the Operators tab, add the operator you just created, click Add, and then click OK.
7. Edit the xMattersSycnList.xml file to look like the following (replace operatorname and

assignmentname with the operator and assignment group you just created):
<synclist>
<users action="include">
<user name="operatorname"/>

</users>
<groups action="include">
<group name="assignmentname"/>

</groups>
</synclist>
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8. Restart the Service Manager client.
9. Open the custom Sync Report form (see "Adding buttons and menus to the Sync Report form" on page 26 for

instructions how to add a menu item for this).
10. In the drop-down list in the upper right, select Sync Now.

l This should synchronize the operator and assignment that you just added to HP Service Manager into xMatters as
a User and Group.

11. Log in to xMatters to check that the user and group was properly synchronized.

Note: The xMatters User target name is the HP Service Manager contact’s operator ID and the xMatters Group name is
the HP Service Manager assignments name.

3.2 Triggering a notification
In this example, an event will be injected to xMatters for notification to the group configured in the user and group
Synchronization example.

1. In Service Manager, open Menu Navigation > Change Management > Changes > Open New Change.
2. Specify the following values in the required fields:

l Impact: either 1- Enterprise or 2 - Site/Dept.
l Urgency: either 1 - Critical, or 2 - High.

3. Enter values for all other required fields:

4. Click Submit.

This should inject the change request parameters into xMatters, triggering a new subscription notification -- if you have
created a subscription. For more information, see "Creating a subscription" on page 19. Changing the phase of the change
request to one that requires approval should inject a targeted notification for the approvers that are defined in the approval
associated to the Change Phase in the Approvals Section of the HP Service Manager.

3.3 Responding to a notification
This section describes how to respond to a notification from xMatters. In the following example, the notification is received
in an HTML email format, but the process is similar for all devices.

To respond to a notification:

1. When a notification arrives, open it to view its details:

2. To respond to a notification, click a response choice, and xMatters sends the response:

For more information about response choices, and changing the options available to users, see "Response choices" on page
32.

3.4 Viewing response results
When an action is taken on an xMatters notification, that action is reflected in the original change request. When xMatters
makes changes to a ticket, it also updates the Historic Activities field on the change request.

To view the notification results:

1. In Service Manager, open Menu Navigation > Change Management > Changes > Search Changes.
2. In the Change ID field, type the ID of the change request you want to view, and then click Search.
3. Scroll down to the Activities section to view the updates:
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For each user device notified during this process, the Journal Updates log will be annotated with a message indicating
“Successful Delivery for bsmith|Work Email” where “bsmith|Work Email” is the recipient (<User>|<Device>).

3.5 Testing subscriptions
To test subscriptions, ensure that you have created a Subscription (for more information, see "Creating a subscription" on page
19). Trigger a notification that matches the criteria that you have configured your subscription to match. You will receive an
FYI Notification (informational only) which will not have any response choices available.
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Chapter 4: Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend the xMatters for HP Service
Manager Change Management integration.

4.1 Adding new parameters
Additional data elements (or tokens) can be forwarded to xMatters by adding them in HP Service Manager. The
following steps explain how to add a new event token to the event injected to xMatters.

To add an event token:

1. In HP Service Manager, click Menu Navigation > Tailoring > Script Library.
2. In the Name field type AlarmPointCMEvent, and then click Search.
3. Find the addEvent function.
4. Locate the util.addAPXMLData section.
5. Within the section, insert a new line using the following syntax:
util.addAPXMLData(apxml, "token_name", "string", record.action, true);

Where:
l token_name: a descriptive name for the new event token.
l string: the data type.
l record.action: "record" is the incident record, and "action" is the field name in HP Service Manager.

6. Click Save.

To help illustrate how this appears in HP Service Manager, the following image was provided by an xMatters
consulting partner:

To view a description of the field information for your parameter, click Window > Preferences > Expand
HP Openview ServiceManager > Appearance, and then select the Show context-sensitive help debug information
check box. Place your cursor in the field, and then press Ctrl-H.

4.1.1 Adding new tokens to notification content
Once you have injected the new data elements, you can add the token as a parameter to the notification content for
devices. The following steps explain how to add the custom parameter to email notifications; adding content for
other device types is similar and requires the presentation script to be modified for the specific devices.

To add a new token to email notification content:

1. Open the xMatters Developer IDE and check out the HP Service Manager Change Management (BUSINESS)
Script Package.
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2. In the Presentation Action Script, add the following line to the email content creation section:
$content.message = $content.message & "TokenName: " & $event.token_name & "\n"

3. You can also add a check in the Initial script to confirm that the custom parameter was injected properly and exists
within the Action Scripts:

IF ( ! EXISTS( $event. token_name ) )
$event. token_name = $undefined_default
IF ( $main.debug )
@script::log( $main.log_prepend & "Optional token ' token_name '
not found, defaulting to '" & $event. token_name & "'" )

ENDIF
ENDIF

Your custom parameter should now appear in your notification content for email devices.

4.2 Response choices
This integration allows recipients to respond to notifications with several default choices, some of which are injected back to
the HP Service Manager server, updating the original change request. Users notified on email devices also have the ability to
respond with an extra annotation message which will be logged in the original HP Service Manager change request.

The following is a list of the default response choices available with the integration and their associated actions on the
xMatters event and the change request.

Response xMatters Action HP Service Manager Update Availability

Approve Signifies that the User approves the
change request, and delinks all Users
from the change request.

The approval record for the change
request is updated with the Approve
response. The response and any
additional notes added to the
response are recorded in the change
request's Activities tab.

All non-FYI devices

Deny Signifies that the User denies the
change request, and delinks all Users
from the change request.

The approval record for the change
request is updated with the Deny
response. The response and any
additional notes added to the
response are recorded in the change
request's Activities tab.

All non-FYI devices

Annotate Halts delivery of notifications to any
other Devices the responding User
may have configured.

Any additional notes added to the
response are recorded on the change
request’s Journal Updates.

This functionality is
available for Email
Devices only.

Default response choices

4.2.1 Adding annotation messages
Two-way email Device notifications (not FYI) can add extra annotations that will be added to the change request as a
message on the Journal Updates tab. To add an extra annotation, respond to an email notification with the following format
in the subject line:
RESPONSE <Choice> <Message>

<Choice> can be any of the response choices listed in the table above, and <Message> can be any content you want to add
as the annotation.
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4.2.2 Responses for sync errors
Sync Error notifications are based on the hpsmcm-3-0 event domain. These create an event within xMatters and the available
responses do not have any effect on the HP Service Manager system.

4.3 Delivery Annotations
This integration extensively annotates the originating HP Service Manager change request for each device to which a
notification is delivered, but this may not be desirable in all environments. To prevent the delivery annotation of a change
request, change the "ANNOTATEDELIVERY" event domain constant to false.

4.4 FYI Notifications
You can make all notifications informational only (i.e., the user is not offered any response choices) by modifying the event
domain constants. Setting the FORCEFYI event domain constant to "on" makes all normal and subscription notifications
one-way (FYI).

4.5 Adding custom trigger rules
To add a custom trigger rule that will trigger a notification to be injected into xMatters:

1. Click Menu Navigation > Tailoring > Script Library.
2. Type AlarmPointCMEvent in the Name field.
3. Click Search.
4. Modify the following methods to suit your requirements:

l getTriggerRule() - This method is used to determine whether a notification should be injected into xMatters.
l getDeviceFilter() - This method is used to return a device filter string that will limit the devices to which that
notification will be sent.

For example, the default behavior is to inject a notification into xMatters upon change creation. To modify this to only inject
a notification on creation when the urgency is either critical or high, change the following lines:
else{
triggerRule = "Creation";

}

To:
else{
if(record.severity <= 2)
triggerRule = "Creation";

}

4.6 Altering the duration of events
You can modify the amount of time xMatters will send out notifications for a particular event before it times out by changing
the timeout event domain constant. This constant stores the number of seconds the notifications will be allowed to continue
before timing out.

For example, if you wanted to change the event duration to two hours, you could change the value for the timeout constant
to 7200.
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4.7 Filtering and suppression
The xMatters integration agent's Portable Filtering and Suppression Module is a built-in module that maintains a rolling
record of previously injected events, and allows for the suppression of duplicates (also referred to as "deduplication"). This
helps avoid disruption of traffic due to inadvertent loads that can result when, for example, improperly configured
management systems inject duplicated events.

The deduplicator-filter.xml file is installed in the <IAHOME>\conf folder and is configured to suppress duplicate events
for 30 minutes (up to a maximum of 100 events in that period).

This filter can be modified to extend the time period over which an event is considered to be a duplicate, the number of
events in that period and the tokens that are used to determine what makes the event unique.

For example, to add NEW_VALUE_NAME to the tokens, open the deduplicator-filter.xml file in a text editor and add
the following line to the <predicates> collection:
<predicate>NEW_VALUE_NAME</predicate>

Save the file and restart the integration agent for the changes to take effect.

Note: To see a complete list of predicates available in the integration, review the Event Data in the Event Summary
Report in the xMatters web user interface.

4.8 HP Service Manager logging
All of the integration actions and errors are printed out to the messages panel and logged to the standard HP Service Manager
log file specified in the sm.ini configuration file. These messages are defined in the AlarmPointUtil script library and are in
the following format:
var RECIPIENT_UPDATE_FAIL = "Failed updating xMatters %% %% - %%";

Messages are displayed using the following function:
logMessage(messageId, <args>)

where messageId matches the variable used to define the message and <args> is replaced by as many arguments as you
want. These extra arguments are used in order to replace all occurrences of %% in the defined message.

For example, to log the message ‘Failed updating xMatters Team TELECOMS-24x7 - UNKNOWN_GROUP’, you would use
the following:
logMessage("RECIPIENT_UPDATE_FAIL", "Team", "TELECOMS-24x7", "UNKNOWN_GROUP");

This would print in the Service Manager log file as:
3204( 2656) 12/04/2007 11:15:26 JS I Failed updating xMatters Team TELECOMS-24x7 - UNKNOWN_
GROUP

4.9 Uninstalling
For instructions on removing an xMatters deployment, refer to the xMatters installation and administration guide.

This integration does not include an uninstall utility; you must remove the installed components manually. For a list of the
components, see "Installing integration components" on page 5
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Chapter 5: Configuration Variable Reference
This section outlines and describes the configuration variables available in the initial PROCESS Action Script.

5.1 Global configuration variables
These variables are available throughout the script package, and are parameters of the “main” object. The value
assigned to each variable is its default value within the script.

Variable Description

$main.use_logFile = true Specify whether to use an alternate log file for debugging
messages. This variable is ignored unless event domain
constant is also set to true.

$main.logFile = "../logs/HP_SM_CM_Script.log" Defines the file used to log debugging information (only
if $main.use_logfile is set to true).

$main.HTML_form_url = $main.xmatters_url &
"/jsp/ProcessNotificationResponse.jsp"

Specifies the URL of the xMatters web server’s Process
Notification Response JSP form, used by HTML email and
BES to inject responses through the system.

$main.logo_alt_text = “[If the logo does not appear
you may be blocking images or you may be outside
a firewall. If the latter, the links will not work for
responding and you should respond by replying to
this email as described below.]”

The alternate text to display if the HTML email logo is
unavailable.

Note: If the logo does not display, it is unlikely that the
HTML_form_url is valid and responses will not be
injected from HTML Devices (email and BES).

Global variables
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